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REGULATION INFORMATION  

The StenoCast RED must be installed and used in strict accordance with the manufacturer’s 
instructions.  This device complies with the following radio frequency and safety standards. 
This device complies with Part 15 of the FCC Rules.  Operation is subject to the following two 
conditions: 
(1) This device may not cause harmful interference. 
(2) This device must accept any interference received, including interference that may cause 

undesired operation.  

Federal Communication Commission Interference Statement 
This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses and can ra-
diate radio frequency energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio communications. However, there is no guarantee that interfer-
ence will not occur in a particular installation. If this equipment does cause harmful interference to 
radio or television reception, which can be determined by turning the equipment off and on, the 
user is encouraged to try to correct the interference by one or more of the following measures: 

Reorient or relocate the antenna. 
Increase the separation between the equipment and the receiver. 
Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected. 
Consult the dealer or an experienced radio/TV technician for help.  

Installation and use of this Wireless LAN device must be in strict accordance with the 
instructions included in the user documentation provided with the product. Any changes or modifi-
cations (including the antennas) made to this device that are not expressly approved by the manu-
facturer may void the user’s authority to operate the equipment. The manufacturer is not respon-
sible for any radio or television interference caused by unauthorized modification of this device, or 
the substitution of the connecting cables and equipment other than manufacturer specified. It is the 
responsibility of the user to correct any interference caused by such unauthorized modification, 
substitution or attachment. 
Manufacturer and its authorized resellers or distributors will assume no liability for any 
damage or violation of government regulations arising from failing to comply with these guidelines. 
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Thank you for purchasing the StenoCast RED Wireless Realtime System 

featuring Bluetooth wireless technology.  The StenoCast RED creates a wireless          
connection between the Court Reporter’s laptop and up to seven attorney/client lap-
tops.    

FEATURES  

Support for Microsoft Windows 2000, XP Home, Windows XP Pro, Vista and   
Windows 7 
Easy operation and setup 
Sends a Wireless Realtime Signal to up to seven clients  

SYSTEM REQUIREMENTS  

One available USB port.     
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StenoCast RED Quick Setup Guide 

Step 1: 
Check the contents of your StenoCast RED System.  There should be: 

1 StenoCast RED Unit 
1 USB cable 
1 StenoCast Utilities CD (includes both Reporter and Client manual in PDF format) 

Step 2:   

Insert the StenoCast CD into your com-
puter.  The CD will start automatically and 
install the driver.    

Windows 7 and Vista Users:  You will 
be prompted to allow the program 
“StenoCast Driver” to continue. If your 
User Account Control (UAC) is turned 
on, Click “Continue” and the driver      
installation will proceed.   

Step 3:  

You will then see the driver installation 
progress bar.   When the driver has been 
installed, you will be asked if you would 
like to install your StenoCast Device.  Plug 
in your StenoCast RED to the USB port of 
your computer, then click “Yes.” 
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Step 4:  

After you click “Yes,” Windows will proceed to install the RED, and a progress bar will appear.                  

Once the RED has been installed, an information window will appear and display the COM ports that have 
been assigned to your StenoCast RED.  You are now ready to configure your CAT software for sending  
realtime via your StenoCast RED. 
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Step 1:   

From the Default screen click the  Translate button 
or type Ctrl+T to enter the Translate window.  In 
this window make sure the Output To pull-down 
menu is set to CaseView and the Remember  
Setting box is Checked.  Next, click the Options 
tab in the lower left corner of the translate window.     

Step 2:  

Click the Output to CaseView tab.  In this      
window insert the lower of the two listed COM Port 
number that were displayed on your screen when 
you installed the StenoCast RED drivers (page 6).  
(For example, if COM ports 7 and 8 displayed, insert 
COM 7).    

Also, make sure that the Output over comm port 
box is checked and the Direct (Cable) bubble is 
selected.   

Your CaseCatalyst software is now configured to 
use the StenoCast RED.  To set up an attorney or 
client computer to receive realtime from the   
StenoCast RED, please see the RED Client Manual. 

Case Catalyst Configuration 
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Step 1:  

From the default screen Click the 
Settings button in the upper left 
area of the screen.   

Step 2:  

Click the Realtime tab near the 
top of the window.  You should 
see the current output format in 
this window.    

Now, click the Add or Change 
button under Output formats.  
This will open the Output format 
window. 

Total Eclipse Configuration 
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Step 3:   

Use the pull-down menu next to Output and select  Summation/CaseView.  
Next, click the Setup button.  This will open the COM Port Setup window 
(Pictured below).  Enter the lower of the two listed COM Port numbers that were 
displayed on your screen when you installed the StenoCast RED drivers (page 6).  
(For example, if COM ports 8 and 9 displayed, insert COM 8 here).    

Set the Baud rate to 2400.    

You will repeat the above process, and in the Output format menu select Bridge.  
Click the Setup button.  Make sure the higher of the two RED COM Port numbers 
is entered here (In our example above, it would be 9) and set the baud rate to 38K or 
38,400. 

When you have completed the    
StenoCast RED configuration, your 
Total Eclipse Output formats      
window will look similar to the one 
pictured here. 
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DigitalCAT Configuration 

Step 1:  

From the default screen of DigiCat, Click 
the Options tab and select CIC from 
the menu.  This will open the CIC Setup 
window. 

Step 2:  

Once in the CIC Setup window insert the lower 
of the two listed COM Port numbers that were 
displayed on your screen when you installed the 
StenoCast RED drivers (page 6).  (For example, if 
COM ports 7 and 8 displayed, insert COM 7 
here).    

Set the baud rate to 2400.  That’s it for the 
setup.    

Proceed to Step 3 to initiate realtime          
transmission in DigiCAT. 

Step 3:  

In order to send out Realtime in  DigiCat, 
Realtime must be initialized.  When starting 
Realtime, select the Tools menu from the 
default screen.  Then find CIC on the pull-
down menu and select Start Session.     
DigiCat will now send out Realtime.    

To set up an attorney or client  computer to 
receive realtime from the StenoCast RED, 
please see the RED Client Manual. 
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StenoCAT Configuration 

Step 1:  

From the default screen open the Tools 
menu at the top of the   window.  Then 
select User    Preferences from the 
menu. 

Step 2:  

You should now see the User Preferences 
window.  First, click on the Realtime tab near 
the top of the window.  Make sure the bubble 
next to Serial Connection is selected.    

In the Port drop-down menu insert the lower of 
the two listed COM Port numbers that were  
displayed on your screen when you installed the 
StenoCast RED drivers (page 6).  (For example, if 
COM ports 7 and 8 displayed, insert COM 7 
here).    

Set the Baud rate to 2400.    

Next, check the Setting pull-down menu.  It 
should show 8-N-1.    

Make sure the Output Type is set to 
CaseView.  Click OK to save the  settings.    

Your Realtime output settings are now          
configured for your StenoCast RED. Proceed to 
the next page for connection instructions.   
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Step 3:  

From the default screen open the File menu.  
Then select Start Realtime.   

Step 4:  

From the Realtime window select Start new 
job (or append to existing job if you wish).  Then 
click OK. 

Step 5:  

Choose a name for the new job (or select an   
existing file if appending an existing job).  Then 
click OK.  That’s it.  You are now sending out 
realtime wirelessly with your StenoCast RED.  

To set up an attorney or client computer to    
receive realtime from the StenoCast RED, please 
refer to the RED Client Manual. 
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SmartCAT Configuration 

Step 1:  

From the default screen open the Setup 
menu at the top of the window.  Then select  
Realtime Options from the menu. 

Step 2:  

At the Realtime Options window select 
Caseview as your Output Format.    

Then click the Setup button that is directly 
next to the Output Format. 

Step 3:  

Once in the Caseview Output  Settings 
window, at the Port drop-down menu, insert 
the lower of the two listed COM Port    
numbers that were displayed on your screen 
when you installed the StenoCast RED    
drivers (page 6).  (For example, if COM ports 
7 and 8 displayed, insert COM 7 here).    

Proceed to the next page for instructions on 
how to send out  realtime with SmartCAT. 
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Step 4:  

To start realtime in SmartCAT, 
open the File menu near the top 
of the window.  Then select New 
Job from the menu. 

Step 5:  

At the New Job  window enter all appropriate      
information and then Click OK. 

Step 6:  

Open the Realtime menu near the top of the 
window.  Then select Start Realtime.    

You are now  sending out Realtime wirelessly 
with your StenoCast RED.    

To set up an attorney or client computer to   
receive realtime from the StenoCast RED, please 
see the RED Client Manual. 
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Getting familiar with your StenoCast RED 

(Refresh-Enabled Device)  

Almost all reporters will connect to their RED via their USB port. You may plug the 
RED directly into the computer’s USB port or use a powered USB hub.  

Before your first use, insert the StenoCast CD into your CD drive. The CD starts 
automatically and loads quickly.  Once your RED driver is installed, if you neglected to 
note the two COM port numbers assigned to the StenoCast RED, proceed to Device 
Manager and look at Ports to determine what COM ports the RED was assigned to. 
They will be entitled, “StenoCast RED” followed by the COM port number. Jot those 
COM port numbers down and then enter those number in your CAT software’s   
outgoing realtime settings.  

Note:  You will see two StenoCast RED devices listed under Ports; for example, 
COM port 4 and COM port 5. The first listed RED device with the smaller COM port 
number (COM port 4 in our example) is the device that transmits to Clients using the 
CaseView protocol at the 2400 baud rate; and the second listed RED device, with the 
larger COM port number (COM port 5 in our example) is the device that transmits 
to Clients using the Bridge protocol at the 38,400 baud rate.     

Operation Instructions  

1) Make sure your computer is turned on, then plug the USB cable into the RED and 
the other end into your computer. 

2) Have the Judge/Attorneys plug in their USB Ez Receivers (Red or Blue) and open 
up a realtime file in their litigation-support software. 

3) The RED will automatically go into Test Mode.  The RED will transmit the      
message “Wireless Connection Successful” every ten seconds.  This will allow the 
parties to test the realtime signal without the reporter hitting keys on their steno 
machine.  Test mode will stop once the reporter hits their first steno stroke.  To 
re-initiate Test Mode, unplug the USB cable attached to the RED and then plug it 
back in.  That will restart the RED and re-initiate Test Mode. 
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LCD Screen Messages  

StenoCast RED 
Status Ready  

Your RED is plugged into either the USB port or the USB hub, and the RED 
unit is powered on.  No wireless connection has been established with any 
Ez Receivers.    

StenoCast RED 
Clients Online  

One or more Ez Receivers have connected with the RED.  Realtime is ready 
to be initiated.  If no steno strokes have been hit, Test Mode will be initiated.    

Clients Online 
Realtime Online  

The wireless connection is established and realtime is being transmitted by 
the RED and received by one or more Ez Receivers.     
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Step 1:  

Turn on your laptop or computer if you have not already done so.  
Now we will check the COM port number of your StenoCast RED.  
From your Windows desktop click   

Windows Logo>CONTROL PANEL  

Step 2:  

Make sure you are in Icon View.  If you are 
not, just change to Large or Small Icon view 
via the pull-down menu in the upper right.        

Checking Com Port Settings - 
Windows Vista & 7 

http://www.stenocast.com/support_return_policies.php


 

18 
Buyer acknowledges and accepts all support, service agreement and return policy terms and conditions as listed 

at: www.stenocast.com/support_return_policies.php

 
Step 3:  

Once in Icon view, click the Device 
Manager Icon 


